Regulatory Compliance

The ICE-1000/ICE-2000 emulators are designed to be used solely in a laboratory environment. The emulators are not intended for use as consumer end products or as a portion of consumer end products. The emulator boards are open system designs which do not include shielded enclosures and therefore may cause interference to other electrical devices in close proximity. These boards should not be used in or near any medical equipment or RF devices.

The emulators have been certified to comply with the essential requirements of the European EMC directive 2004/108/EC and, therefore, carry the “CE” mark.

The ICE-1000/ICE-2000 emulators have been appended to Analog Devices, Inc EMC Technical File (EMC TF) referenced DSPTOOLS1, issue 2 dated June 4, 2008 and were declared CE compliant by an appointed Notified Body (No.0673) as listed below.


Issued by: Technology International (Europe) Limited
56 Shrivenham Hundred Business Park
Shrivenham, Swindon, SN6 8TY, UK

The emulator contains ESD (electrostatic discharge) sensitive devices. Electrostatic charges readily accumulate on the human body and equipment and can discharge without detection. Permanent damage may occur on devices subjected to high-energy discharges. Proper ESD precautions are recommended to avoid performance degradation or loss of functionality. Store unused emulators in the protective shipping package.
CONTENTS

PREFACE
Purpose of This Manual .............................................................. viii
Intended Audience ................................................................. viii
Manual Contents ...................................................................... viii
What's New in This Manual ....................................................... ix
Technical Support ................................................................... ix
Product Information .............................................................. x
  Analog Devices Web Site ..................................................... x
  EngineerZone ................................................................... xi
Notation Conventions .......................................................... xii

GETTING STARTED
Contents of Emulator Package .................................................. 1-2
PC Configuration ........................................................................ 1-2
Emulator Installation Tasks ...................................................... 1-3
  Installing the Emulator Software ........................................ 1-3
  Configuring Operating Voltage of the JTAG/SWD Interface
    on an ICE-1000 ........................................................... 1-4
  Configuring Operating Voltage of the JTAG/SWD Interface
    on an ICE-2000 ........................................................... 1-5
Contents

Verifying Driver Installation and Attaching to an Emulation Target ................................................................. 1-5
Applying Power to the Emulator .............................................. 1-7
Configurator Software ............................................................... 1-8
JTAG/SWD Frequency ............................................................... 1-9
Troubleshooting and Warranty ................................................. 1-9

HARDWARE DESCRIPTION

LED ............................................................................................. 2-1
Connectors .................................................................................. 2-2
Resetting the Target .................................................................... 2-2
Custom Processor Boards ........................................................... 2-3
Mechanical Specifications .......................................................... 2-3

SUPPORT

Technical Support ......................................................................... 3-1
Quality Assurance ......................................................................... 3-2

REFERENCES

INDEX
Thank you for purchasing the ICE-1000 or ICE-2000 emulator. The emulator is used in conjunction with the CrossCore® Embedded Studio or VisualDSP++® development environments to create, test, and debug advanced processor application software on Analog Devices Blackfin®/Blackfin+™ and SHARC®/SHARC+™ processor families.

The emulator provides state-of-the-art support for JTAG-compliant Analog Devices processors. Key features of the emulator include:

- Plug-n-Play, USB 2.0 compliant
- High-speed USB device
- USB bus-powered device
- Multiple processor I/O voltage support: 1.8V, 2.5V, and 3.3V compliance
- Multiprocessor support
- JTAG/SWD clock operation of 5 MHz on the ICE-1000
  JTAG/SWD clock operation up to 46 MHz on the ICE-2000

To learn more about Analog Devices emulators, go to:

Purpose of This Manual

The ICE-1000/ICE-2000 Emulator User’s Guide provides directions for installing the emulator hardware and software on your PC.

Intended Audience

This manual is intended to help the customer understand the features and operation of the emulator so they can start using CrossCore Embedded Studio (CCES) and VisualDSP++.

Manual Contents

The manual consists of:

- Chapter 1, Getting Started
  Provides software and hardware installation procedures, PC system requirements, and basic board information.

- Chapter 2, Hardware Description
  Provides information on hardware aspects of the emulator.

- Chapter 3, Support
  Provides technical support contact information.

- Chapter 4, References
  Provides information about different resources available for developing an application based on an Analog Devices processor.
What’s New in This Manual

This is Revision 1.2 of the ICE-1000/ICE-2000 Emulator User’s Guide. The updates to the manual include:

- CE certification for the ICE-1000/ICE-2000 emulators
- Modifications and corrections based on errata reports against the previous manual revision

For the latest version of this manual, please refer to the Analog Devices Web site.

Technical Support

You can reach Analog Devices processors and DSP technical support in the following ways:

- Post your questions in the processors and DSP support community at EngineerZone®:
  http://ez.analog.com/community/dsp

- Submit your questions to technical support directly at:
  http://www.analog.com/support

- E-mail your questions about processors, DSPs, and tools development software from CrossCore Embedded Studio or VisualDSP++:
  Choose Help > Email Support. This creates an e-mail to processor.tools.support@analog.com and automatically attaches your CrossCore Embedded Studio or VisualDSP++ version information and license.dat file.
E-mail your questions about processors and processor applications to:
processor.support@analog.com or processor.china@analog.com (Greater China support)

Contact your Analog Devices sales office or authorized distributor. Locate one at:
www.analog.com/adi-sales

Send questions by mail to:
Processors and DSP Technical Support
Analog Devices, Inc.
Three Technology Way
P.O. Box 9106
Norwood, MA 02062-9106
USA

Product information can be obtained from the Analog Devices Web site and the CCES online help.

Analog Devices Web Site


To access a complete technical library for each processor family, go to http://www.analog.com/processors/technical_library. The manuals selection opens a list of current manuals related to the product as well as a link to the previous revisions of the manuals. When locating your manual title, note a possible errata check mark next to the title that leads to the current correction report against the manual.
Also note, myAnalog is a free feature of the Analog Devices Web site that allows customization of a Web page to display only the latest information about products you are interested in. You can choose to receive weekly e-mail notifications containing updates to the Web pages that meet your interests, including documentation errata against all manuals.

myAnalog provides access to books, application notes, data sheets, code examples, and more.

Visit myAnalog to sign up. If you are a registered user, just log on. Your user name is your e-mail address.

**EngineerZone**

EngineerZone is a technical support forum from Analog Devices. It allows you direct access to ADI technical support engineers. You can search FAQs and technical information to get quick answers to your embedded processing and DSP design questions.

Use EngineerZone to connect with other DSP developers who face similar design challenges. You can also use this open forum to share knowledge and collaborate with the ADI support team and your peers. Visit http://ez.analog.com to sign up.
Notation Conventions

Text conventions used in this manual are identified and described as follows.

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File &gt; Close</td>
<td>Titles in bold style reference sections indicate the location of an item</td>
</tr>
<tr>
<td></td>
<td>within the CrossCore Embedded Studio's menu system (for example, the Close</td>
</tr>
<tr>
<td></td>
<td>command appears on the File menu).</td>
</tr>
<tr>
<td>{this</td>
<td>that}</td>
</tr>
<tr>
<td></td>
<td>brackets and separated by vertical bars; read the example as this or that.</td>
</tr>
<tr>
<td></td>
<td>One or the other is required.</td>
</tr>
<tr>
<td>[this</td>
<td>that]</td>
</tr>
<tr>
<td></td>
<td>by vertical bars; read the example as an optional this or that.</td>
</tr>
<tr>
<td>[this,...]</td>
<td>Optional item lists in syntax descriptions appear within brackets</td>
</tr>
<tr>
<td></td>
<td>delimited by commas and terminated with an ellipsis; read the example as an</td>
</tr>
<tr>
<td></td>
<td>optional comma-separated list of this.</td>
</tr>
<tr>
<td>.SECTION</td>
<td>Commands, directives, keywords, and feature names are in text with</td>
</tr>
<tr>
<td></td>
<td>letter gothic font.</td>
</tr>
<tr>
<td>filename</td>
<td>Non-keyword placeholders appear in text with italic style format.</td>
</tr>
</tbody>
</table>

Note: For correct operation, ...
A Note provides supplementary information on a related topic. In the online version of this book, the word Note appears instead of this symbol.

Caution: Incorrect device operation may result if ...
Caution: Device damage may result if ...
A Caution identifies conditions or inappropriate usage of the product that could lead to undesirable results or product damage. In the online version of this book, the word Caution appears instead of this symbol.

Warning: Injury to device users may result if ...
A Warning identifies conditions or inappropriate usage of the product that could lead to conditions that are potentially hazardous for devices users. In the online version of this book, the word Warning appears instead of this symbol.
1 GETTING STARTED

This chapter provides the information needed to begin using Analog Devices emulators.

Analog Devices emulators are not intended to be used in a production environment.

This chapter includes the following sections.

- **Contents of Emulator Package**
  Provides a list of components shipped with the emulator.

- **PC Configuration**
  Describes the minimal PC requirements.

- **Emulator Installation Tasks**
  Provides a step-by-step procedure for setting up the emulator hardware and describes how to connect the emulators to your target board.

- **Configurator Software**
  Describes the target configurator utility.

- **JTAG/SWD Frequency**
  Provides information on JTAG/SWD frequency limitations.

- **Troubleshooting and Warranty**
  Points to an Engineer-to-Engineer Note for troubleshooting advice and warranty information.
Contents of Emulator Package

The ICE-1000 emulator package contains the following items:

- ICE-1000 emulator
- 2-meter USB standard-A to mini-B cable

The ICE-2000 emulator package contains the following items:

- ICE-2000 emulator with enclosure
- 6-inch 0.05” cable assembly
- 10-pin to 14-pin adapter used for connecting to the legacy 0.1” 14-pin JTAG header
- 2-meter USB standard-A to mini-B cable

PC Configuration

For correct operation of the emulator, your computer must have the minimal configuration:

- Windows 7
- CrossCore Embedded Studio 1.1.0 (or higher) or VisualDSP++ 5.1.1 (or higher)
Emulator Installation Tasks

Perform the following tasks to install your emulator safely. Follow the instructions in presented order to ensure correct operation of your software and hardware.

1. Installing the Emulator Software
2. Configuring Operating Voltage of the JTAG/SWD Interface on an ICE-1000
3. Configuring Operating Voltage of the JTAG/SWD Interface on an ICE-2000
4. Verifying Driver Installation and Attaching to an Emulation Target
5. Applying Power to the Emulator

Installing the Emulator Software

Install CCES 1.1.0 (or higher) or VisualDSP++ 5.1.1 (or higher) on your computer. The software installation includes the USB driver needed for the emulator hardware.

Note: If you connect to the ICE before installing the software, the Windows driver wizard may not find the emulator driver.
Configuring Operating Voltage of the JTAG/SWD Interface on an ICE-1000

Determine the operating voltage of the JTAG/SWD interface of the target processor. The ICE-1000 emulator ships configured for connecting to a 3.3V target. The jumpers are installed on positions 1 and 3, and 2 and 4 (default) of JP1. Refer to Table 1-1 and Figure 1-1 for configuring other voltages.

Table 1-1. Operating Voltage

<table>
<thead>
<tr>
<th>Target Voltage</th>
<th>JP1 Settings (Installed Jumpers)</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.3 volts</td>
<td>1 and 3, 2 and 4</td>
</tr>
<tr>
<td>2.5 volts</td>
<td>1 and 2, 3 and 4</td>
</tr>
<tr>
<td>1.8 volts</td>
<td>3 and 5, 2 and 4</td>
</tr>
</tbody>
</table>

Figure 1-1. JP1 Pinout
Getting Started

Configuring Operating Voltage of the JTAG/SWD Interface on an ICE-2000

Determine the operating voltage of the JTAG/SWD interface of the target processor. On the ICE-2000 emulator, the voltage is configured when making a platform using the configurator. The default voltage is 3.3V. Refer to the online help for information about “target configurator”.

Before connecting to a target, see the power-up/down procedures in Applying Power to the Emulator.

Verifying Driver Installation and Attaching to an Emulation Target

Before using the emulator, verify that the driver software is installed properly.

1. Open the Windows Device Manager and verify that the ICE-1000 or ICE-2000 emulator appears under CrossCore Tools, as shown in Figure 1-2.

2. When connecting to a 10-pin header on a target board, connect to either the 6” cable when using the ICE-2000 or to the (J2) connector (located on the bottom of the board) when using the ICE-1000. The 10-pin housing is keyed to ensure that the signals mate correctly with the 10-pin target emulation header. The target board should also have keyed housing. Refer to Figure 1-3 for the J2 and cable pinout information.
When connecting to a 14-pin header on a target board, connect to either the 6” cable along with the supplied adapter board when using the ICE-2000 or to the (J1) connector (located at the end) when using the ICE-1000.
The 14-pin connector is keyed at pin 3 on the emulator connector to ensure that the signals mate correctly with the 14-pin target emulation header. The target board should also have pin 3 of the JTAG interface connector cut. Refer to Figure 1-4 for J1 and adapter board pinout information.

![Figure 1-4. J1 Pinout](image)

### Applying Power to the Emulator

To power up the emulator:

1. Apply power to the target board.
2. Connect the USB cable between the emulator and the PC.
   
   The emulator is a bus-powered device, so this step powers the emulator.
3. If the emulator is not connected to the target, connect the devices as described in Verifying Driver Installation and Attaching to an Emulation Target.
4. Invoke CrossCore Embedded Studio or VisualDSP++.
To power down the emulator:

1. Shut down (exit) CrossCore Embedded Studio or VisualDSP++.
2. Disconnect the USB cable between the emulator and the PC.
3. Power down the target board.
4. The emulator can now be removed from the target.

For custom processor boards still in design, refer to an Engineer-to-Engineer Note, “Analog Devices JTAG/SWD Emulation Technical Reference (EE-68)”, available from the Analog Devices Web site. This document is a technical reference for implementing the JTAG/SWD interface on your target.

Now the emulator hardware is ready to be used in conjunction with CCES or VisualDSP++ to debug a processor target system. Refer to Configurator Software for more information.

Configurator Software

CrossCore Embedded Studio and VisualDSP++ development software require a description of your platform (JTAG/SWD chain). The platform definition is necessary for the software to communicate with the hardware through the emulator.

CrossCore Embedded Studio and VisualDSP++ development software include the target configurator utility to configure and test your emulator hardware. The target configurator provides emulator detection and JTAG/SWD I/O voltage. Use the ICE Test (part of the target configurator) to test the connection with the target. If any errors are encountered, the errors are reported immediately and the test ends. Each error message recommends a solution to the problem.
Getting Started

Refer to the online help for information about “target configurator”, “JTAG/SWD voltage”, “JTAG/SWD frequency”, and “ICE test”.

JTAG/SWD Frequency

The ICE-1000 emulator supports JTAG/SWD clock operation at 5 MHz. The ICE-2000 emulator supports JTAG/SWD clock operation at 1, 5, 9, 15, 23 and 46 MHz. There is a relationship between the JTAG/SWD frequency and the core clock frequency of the processor. The core clock should be at least twice the JTAG/SWD frequency in order for the JTAG/SWD interface to operate properly. On newer Analog Devices processors, the core clock is a variable set by software.

⚠️ If the core/JTAG/SWD clock relation is not followed, scan failures may prevent the emulator from connecting to the processor.

Troubleshooting and Warranty

To provide comprehensive troubleshooting advice and warranty information for all emulator and EZ-KIT Lite® products, Analog Devices maintains two Engineer-to-Engineer Notes—Emulator and Evaluation Hardware Troubleshooting Guide for VisualDSP++ Users (EE-175) and Emulator and Evaluation Hardware Troubleshooting Guide for CCES Users (EE-356). Both EE-Notes are available online at http://www.analog.com.

The EE-Note can be used to resolve most installation, connection, and software issues affecting the use of Analog Devices in-circuit emulators (ICEs) and EZ-KIT Lite evaluation systems, avoiding the need to return the suspected faulty emulator or EZ-KIT Lite board. Please carry out all troubleshooting steps outlined in this document before contacting Analog Devices Processor Tools Support.
Troubleshooting and Warranty

Also included in the EE-Note, complete warranty and return material authorization (RMA) information for emulators and EZ-KIT Lite products. In general, emulators less than one year old are within warranty, and repairs within that period are free of charge, but there are some limitations to this warranty coverage. For details, see the note.


2 HARDWARE DESCRIPTION

This chapter describes the hardware design of the ICE-1000/ICE-2000 emulator and includes the following sections:

- **LED**
  Describes the LED which inform you of the emulator’s status.

- **Resetting the Target**
  Describes how to reset the target.

- **Custom Processor Boards**
  Describes concerns regarding board lay out.

- **Mechanical Specifications**
  Provides dimensional information.

**LED**

There is one multicolored LED located on the emulator. It is labeled **Status**.

- Green – Signifies that the ICE is powered, configured, and ready to invoke a CCES or VisualDSP++ session.

- Magenta – Signifies that the ICE is operating in JTAG mode. The LED will blink during USB activity between the host PC and the emulator.
Connectors

- Cyan – Signifies that the ICE is operating in SWD mode. The LED will blink during USB activity between the host PC and the emulator.
- Yellow – Signifies that there is an issue with the EMU signal on the target board and therefore this signal will be ignored by the emulator.

Connectors

There are two connectors on the ICE-1000 used for connecting to a target. J1 is a 0.1" 14-pin connector used for interfacing with legacy targets. This connector only supports debugging via JTAG mode. J2 is a 0.05" 10-pin connector used for JTAG/SWD mode on newer processors.

There is one connector on the ICE-2000. This connects to the 6" ribbon cable that comes with the emulator package. The ribbon cable connects to a 0.05" 10-pin connector on the target board and supports JTAG/ and SWD mode. When connecting the ICE-2000 to older target boards that have the 0.1" 14-pin JTAG connector, there is an adapter that is also included in the box for this connection. The adapter board connects between the cable and target board.

Resetting the Target

When debugging remotely, the ability to reset the target can be very useful. In order to use this feature, the \texttt{RESET} signal from the target board should be connected to \texttt{pin 10} of the 10-pin debug connector. This is an active low signal and is toggled through software.
Hardware Description

To reset the target through the software, use the Reset Target command.

- CCES users choose Target > Debug > Reset Target.
- VisualDSP++ users choose Debug > Reset Target.

The Reset Target command sends a reset pulse of the specified duration to the target. The reset duration is configured by choosing Target > Settings > Reset Target Options. See the online help for more information.

Custom Processor Boards

When designing a custom processor board using Analog Devices processors and DSPs, special care must be taken to ensure that the JTAG/SWD interface is designed and laid out correctly. If the board is not designed correctly, communication via the JTAG/SWD port may not work. Another side effect may be that the interface works, but you are not able to run at the highest possible JTAG/SWD clock frequency. The JTAG/SWD clock frequency is dependent on the particular Analog Devices processor, as well as the delay characteristics of the custom processor board.

To ensure that JTAG/SWD interface of the custom board is designed and laid out correctly, refer to Engineer-to-Engineer Note, Analog Devices JTAG/SWD Emulation Technical Reference (EE-68), available from the Analog Devices Web site. This document is a technical reference for implementing the JTAG/SWD interface on your target.

Mechanical Specifications

The outer dimensions of the emulator are 3.39" x 0.785". The height of the JTAG/SWD connector (J2) is approximately 0.180". Refer to Figure 2-1.
Care must be taken when locating a custom target JTAG/SWD interface connector, that no components are taller than about 0.135” if located under the ICE-1000.

If there are any concerns that emulator components may short to the target board, an insulator should be used to provide protection.
3 SUPPORT

Analog Devices provides free technical support.

Technical Support

For technical support, visit the Embedded Processing and DSP Technical Support page at: http://www.analog.com/support.

From there you can:

- Access the EngineerZone DSP Support Forum where Analog Devices support team members and other designers exchange ideas and answer questions
- Search our vast Knowledge Base containing application notes, data sheets, code examples, manuals, and more
- Contact our Technical Support team directly by filling out the support form

Alternately, you can contact Technical Support directly as follows:

- For tools issues, send a description of the problem by e-mail to: processor.tools.support@analog.com
- For processor issues, send a description of the problem by e-mail to the Application Engineering group at: processor.support@analog.com (World wide support)
Analog Devices is committed to providing quality products and services. To continually provide this quality, please contact our Quality Assurance Department directly if you have any concerns at (603) 883-2430, Monday through Friday during normal business hours, or through e-mail at: processor.tools.support@analog.com.

Our Quality Assurance manager will listen to your concerns and provide a timely and effective solution.
4 REFERENCES

This section describes documentation resources helpful in your application development.

- For information on designing the interface between an Analog Devices processor and the emulation header on your custom processor target board, refer to Engineer-to-Engineer Note, *Analog Devices JTAG/SWD Emulation Technical Reference (EE-68)*, available from the Analog Devices Web site.

- For information on the architecture and system interface of the Analog Devices processor, refer to the appropriate Analog Devices processor hardware reference manual.

- For processor timing specification and other hardware design information, refer to the appropriate processor data sheet.

- For complete information on software development tools (assembler, compiler, linker, and so on), refer to documentation included with CrossCore Embedded Studio or VisualDSP++. This information is available in the online help and PDF format in the Docs folder.

- For information about your development platform, refer to your operating system manuals and hardware system manuals.
INDEX

C
configurator utility, 1-8
configuring operating voltage, 1-4, 1-5
connectors, 2-2
contents, emulator package, 1-2
custom processor boards, 2-3

D
data sheets, 4-1
designing custom boards, 2-3
Device Manager window, 1-5
documentation resources, 4-1
driver installation, 1-5

E
EE-175, 1-1, 1-9
EE-356, 1-1, 1-9
EE-68, 1-8, 2-3, 4-1
emulator connectors, 2-2
emulator troubleshooting, 1-1, 1-9
emulator warranty, 1-9
EngineerZone, xi

F
frequency, 2-3

H
hardware
description, 2-1
references, 4-1
high-speed USB device, vii

I
installation of software, 1-3
I/O voltage, vii

J
JTAG frequency, 1-9
JTAG/SWD
clock frequency, 2-3
clock operation, vii
frequency, 1-9
header, 2-3
port, 2-3
JTAG/SWD frequency, 1-9

L
LED, 2-1

M
mechanical specifications, 2-3
multiprocessor support, vii
Index

P
PC configuration, 1-2
powering up the emulator, 1-7

Q
quality assurance, 3-2

R
resetting the target, 2-2

T
target, resetting, 2-2
technical support, ix, 3-1

V
verifying driver installation, 1-5